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Preface

Audience

This guide is intended for system administrators who will install and configure the ISLE Cluster Manager software to
manage and control the cluster system.

Related Documentation

The following documents provide additional information relevant to the ISLE Cluster Manager product:

- SGI ISLE Cluster Manager System Administrator’s Guide
-+ SGI Altix XE310 User’s Guide
- SGI Altix XE320 User’s Guide

IPMI Management Guide

To access the latter two documents, contact your local sales representative. The following paragraphs describe the
general access method for SGI customer documentation.

You can obtain SGI documentation, release notes, or man pages in the following ways:

- Refer to the SGI Technical Publications Library at http://docs.sgi.com. Various formats are available. This library
contains the most recent and most comprehensive set of online books, release notes, man pages, and other informa-
tion.

- You can also view man pages by typing man <title> on a command line.

SGI systems include a set of Linux man pages, formatted in the standard UNIX “man page” style. Important system
configuration files and commands are documented on man pages. These are found online on the internal system disk (or
DVD-ROM) and are displayed using the man command. For example, to display the man page for the
xscsidisktest command, type the following on a command line:

man xscsidisktest
For additional information about displaying man pages using the man command, see man(1).

In addition, the apropos command locates man pages based on keywords. For example, to display a list of man pages
that describe disks, type the following on a command line:

apropos disk
For information about setting up and using apropos, see apropos(1).
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Audience
Annotations

‘s, Note

SUSE Linux documentation is available at:
http://www.novell.com/documentation/suse.html

RHEL documentation is available at:
https://www.redhat.com/docs/manuals/enterprise/

Annotations

This guide uses the following annotations throughout the text:

Indicates impending danger. Ignoring these messages may result in serious injury or death.

Warns users about how to prevent equipment damage and avoid future problems.

Informs users of related information and provides details to enhance or clarify user activities.

Q, Tip
Identifies techniques or approaches that simplify a process or enhance performance.
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Product Support
Annotations

Product Support

SGI provides a comprehensive product support and maintenance program for its products. SGI also offers services to
implement and integrate Linux applications in your environment.

- Refer to http://www.sgi.com/support/
If you are in North America, contact the Technical Assistance Center at
+1 800 800 4SGl or contact your authorized service provider.
If you are outside North America, contact the SGI subsidiary or authorized distributor in your country.

Reader Comments

If you have comments about the technical accuracy, content, or organization of this document, contact SGI. Be sure to
include the title and document number of the manual with your comments. (Online, the document number is located in
the front matter of the manual. In printed manuals, the document number is located at the bottom of each page.)
You can contact SGI in any of the following ways:
- Send e-mail to the following address: techpubs@sgi.com
- Contact your customer service representative and ask that an incident be filed in the SGI incident tracking system.
- Send mail to the following address:
SGl
Technical Publications
1140 East Arques Avenue
Sunnyvale, CA 94085-4602

SGI values your comments and will respond to them promptly.

007-5513-003






Chapter 1
Installing ISLE Cluster Manager

To set up ISLE Cluster Manager in your environment, you must first install the Cluster Manager Server on a Master
Host. After your Cluster Manager Server is installed, you can create images to distribute the Cluster Manager Client to
the host nodes you want to manage. This lets you monitor and manage compute hosts from a central access point.

System Requirements

Before you attempt to install ISLE Cluster Manager, make sure your master host and compute hosts meet the following
minimum hardware and software requirements:

Minimum Hardware Requirements

Master Hosts

- 2.2 GHz Intel Xeon or AMD Opteron (64-bit)

- 2 GB of RAM (4 GB or more recommended)

- 4 GB local disk space (minimum) — 50 GB or more is typically used

- 100 Mbps management network (including switches and interface card) — 1000 Mbps recommended

Compute Nodes

- 3.0 GHz Intel Pentium 4 (32-bit) or 2.2 GHz Intel Xeon or AMD Opteron (64-bit)

- 1GBRAM

- 100 MB local disk typically used, diskless operation is also supported

- 100 Mbps management network (including switches and interface card) — 1000 Mbps recommended

Supported Platforms

- Intelligent Platform Management Interface (IPMI) 2.0 recommended for power control, serial access, and environ-
mental monitoring

- IPMI 1.5, ILO 1.6 (or later), DRAC 3, and DRAC 4 offer power control only

007-5513-003



System Requirements
Operating System Requirements

Operating System Requirements

Consult SGI before upgrading your Linux distribution or kernel. Upgrading to a distribution or kernel not supported on
your system may render Cluster Manager inoperable or impair system functionality. Technical Support is not provided
for unapproved system configurations.

Cluster Manager Server
You can run Cluster Manager Server on the following operating systems and architectures:

SUSE LINUX ENTERPRISE SERVER 10 (SP 1-2)
- 64-bit AMDG64/EMG64AT hardware

RED HAT ENTERPRISE LINUX 5 (UPDATES 1-3)
- 64-bit AMD64/EMG64T hardware

Cluster Manager Client

You can install and run the Cluster Manager Client on the same operating systems and platforms supported by the
Cluster Manager Server as described above.

In addition, you can install the client software on Windows 2000 or Windows XP using 32-bit x86 Intel or AMD
hardware.

Cluster Manager Kernel Support

SGI recommends using the kernel that shipped with your version of Linux. If you need to upgrade your kernel, please
consult SGI before doing so.

Software Requirements

Cluster Manager requires the following RPM packages:

- Dynamic Host Configuration Protocol (DHCP) — included with your distribution

- Mkelfimage — a program that makes an Executable and Linking Format (ELF) boot image for Linux kernel images
(available on the Cluster Manager CD)

- Tftp-server (if you require PXE Boot support)

- IPMItool (if using IPMI hosts)

IPMItool is required in the payload for each host controlled via IPMI. OpenIPMI is also required in the payloads for
temperature and fan speed monitoring.
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Pre-installation Steps

If you are going to use Intelligent Platform Management Interface (IPMI) hosts, you should configure your host’s BIOS
settings.

Configure the IPMI BMC

The BMC(s) for the nodes should be set up to use networking and serial over LAN. You will also need to know the
username and password that will be used for power control and serial with the BMC(s) in order to use power control
and serial over LAN with the Cluster Manager. The ipmitool utility allows you to set the username and password used
to access the BMC on a host. This tool also allows you to set the LAN parameters of the BMC. For more information,
consult the user’s guide for the SGI Altix XE310 (or XE320), or third-party documentation (in the case of third-party
node types).

Configure the Multicast Route

When provisioning nodes, the default multicast configuration may not work properly. Ensure that multicast routing is
configured to use the management interface.

The following examples use a multicast network of 224.0.0.0/4 to provide broad multicast support, but you can also use
a more narrow multicast route such as 239.192.0.0/16. By default, the base multicast address in Cluster Manager is

239.192.0.128.

SLES

1. Enter the following from the CLI to temporarily add the route (where ethQ is the management interface):
route add -net 224.0.0.0 netmask 240.0.0.0 dev ethO

2. Make the change persistent by entering the following:

vi /etc/sysconfig/network/routes
Then add:

224.0.0.0 0.0.0.0 240.0.0.0 ethO multicast

RHEL

1. Enter the following from the CLI to temporarily add the route (where ethQ is the management interface):
route add -net 224.0.0.0 netmask 240.0.0.0 dev ethO

2. Make the change persistent by entering the following:

vi /etc/sysconfig/network-scripts/route-ethO
Then add:

224.0.0.0/4 dev ethO
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Set Up a Cluster Manager Master Host

After you have installed a Linux distribution and other required software on supported hardware, you are ready to
install Cluster Manager Server. (See Operating System Requirements on page 2.) You can install the server via RPM(s)
or the Cluster Manager installer.

Cluster Manager Server Installation Using RPMs

To install the server via RPMs, do the following:

1. Log on to the system as root.

2. Change directories to the sgi/<arch> directory of the Cluster Manager CDROM.
3. Type the following commands, replacing <version> and <arch> as needed:

rpm —-ivh islecm-java-<version>.<arch>.rpm
rpm -ivh islecm-<version>._<arch>_rpm

rpm -iv islecm-server-<version>.<arch>._rpm
rpm —-ivh IKkSGl-<version>_<arch>.rpm

rpm -ivh IkSGI-java-<version>._<arch>_rpm

You will need to obtain a license from SGI. For information on the SGI LK licensing mechanism, see the

SGI Foundation 1 Service Pack 3 Start Here available at http://docs.sgi.com. Open the /etc/lk/keys.dat file in a text
editor. Copy and paste the license string, exactly as given, and save the file.

Cluster Manager Server Installation Using the Cluster Manager Installer

To install the server using the installer, do the following:

1. Generate or convert the /etc/hosts file for the servers and the compute hosts, then place this file on the Master Host.

The hosts file includes information such as IP address, MAC address, domain, and name of your master host and
your compute nodes. If the information in the hosts file is incorrect, Cluster Manager will not communicate
properly with your compute nodes.

2. Log in as the root user on the master host and insert the Cluster Manager CD.
If the installation does not begin automatically, enter the following in the command line:

run: <cdrom_mount_point>/install.sh
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Set Up a Cluster Manager Master Host

Configure the Multicast Route

3. Review and accept the terms of the license agreement and click Next.

5ot ISLE Cluster Manager Installer - x|

Sgl  ISLE Cluster Manager

Please read the following license agr carefully.

ERD USER LICEMSE ACREEMENT {"Licenze")

CAUTION! THIS LICENSE APPLIES TO SOFTWARE WHICH IS IN ACCOMPANYING PACKAGING,
INCLUDED WITH S$GI HARDWARE PRODUCTS AND/OR DOWNLOADED FROM AN 5GI SITE
{collectively, the "Licensed Software™). YOUR OPENING THE LICENSED SOFTWARE'S PACKAGING,
DOWNLOADING THE SOFTWARE FROM AN 5GI SITE AND/OR YOUR USE OR INSTALLATION OF
THE LICENSED SOFTWARE, INDICATES YOUR ACCEPTANCE OF THE TERMS AND CONDITIONS
OF THIS LICENSE. References herein to "vou™ or "Your” refer to both you and such person or
entity in whose behalf you act, if any, as the original owner of the 5GI hardware productis).

1. General. The Licensed Software consists of a software program protected by copyright and other
applicable intellectual property laws and treaties. Certain Licensed Software programs as defined
in Section 12 below may be wholly or partially subject to other licenses.

Grant of License; Restricted Software Use Restrictions. Subject to applicable restrictions herein,
SC1 hereby grants Youw a limited and non-exclusive license to use the Licensed Software in
conformance with thiz License and the Licenzed Software's accompanving documentation in

™

4. Click Cluster Manager Server and enter the installation directory and Master Host name.

sgi - ISLE Cluster Manager Installer w

sgl

Please select an installation type.

® |SLE Cluster Manager Server

The master host of the cluster. This installs all services necessary for ISLE Cluster
/éh‘\ Manager to work properly. Chaoose this type if wou are configuring the cluster and
@ hawe administrative access.

Client
The I5LE Cluster Manager graphical user interfaces without amy serdces ar additional
canfiguration. The client install can be used on Windows or Linux., Choose this type if
wiou are not the Cluster Administrator or don't have administrative access on the
cluster.

Payload

The basic set of services that run on a host in order to be used within [5LE Cluster
Manager. MOTE: The installer must be run fram the root of the padoad. Choose this
e if wou are configuring the hosts an the cluster and hawve administrative access an
the cluster.

Installation Directory: |fopt/ows Browse

Host Name: host

SILICON GRAPHICS, INC. ("SGI"} -

x

< Back Mext = Cancel

By default, the installation directory is /opt/sgi/islecm. The Master Host name (for example, host) must be present in
the /etc/hosts file or you must be able to resolve it through DNS. This host name should resolve to the management

interface, such as 10.0.10.1. If it resolves to the public interface, the Cluster Manager will not operate correctly.
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To prevent accidentally overwriting Cluster Manager, install on a local file system that is not shared with other hosts.

5.

10.

Click Next.
If the computer does not have required applications installed, the following warning dialog is displayed.

] Installation Warning x

_,-"\ The following applications must be installed to enable full
(s ISLE Cluster Manager functionality:

powerman heeded if using Powerman for host power control

These applications can either be found on the ISLE Cluster Manager
installation CD under the "misc’ directory, or on your Linux
distribution CDs.

Select "Yes” to continue with installation, "Mo” will bring
you back to the Installation Type screen

fres| || No

You can continue the installation, but you will not have full Cluster Manager functionality until you install these
required applications. (The applications can be installed after Cluster Manager has been installed.)

Click Yes to continue the installation.
Review the installation settings and click Install.

The installation process begins and the progress is displayed in the Cluster Manager Installer.

After the installation files have completed copying to the installation directory, you are prompted to install a
Cluster Manager license.

Do yvou wish to install a ISLE Cluster Manager license now?

fres| || No

The license is packaged as a text file — for example, ClusterManager_1.0.txt.
Click Yes and select the license file you want from the file browser.

After the installation completes, click Finish.

Restart your X session before starting Cluster Manager.
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Using the Cluster Manager Interface

The Cluster Manager interface includes menus, a tool bar, tabbed panels, and frames with navigation trees that allow
you to navigate and configure the cluster. From this interface you can add compute hosts and regions to the cluster and
create payloads and kernels to provision the hosts.

Starting Cluster Manager

After you have installed the program and have restarted your X session, you can start the Cluster Manager interface
from the command line interface.

1. Open a command line console.
2. Loginas root.

3. Onthe command line, enter cmclient and press Enter.
The Cluster Manager Login is displayed.

- ISLE Cluster Manager Login x|

3 ISLE
Sgl Cluster Manager

User: root

Password: """

OK Cancel

4, Enter a user name (root by default) and password (root by default) and click OK.
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The Cluster Manager interface is displayed.
System tabs

Menus Tool bar Server name Frame controls
A — o
Eile Edit Yiew Actions Help
e RO 3nNw
" osts @ ax = sl —
Configuration | a# Instrumentatio| Al Provisioning 4 b BEX '
uster -
T!;} computehosts J OvewiewTThumbna\I List | CFU Memory] Disk] Metwark | Kernel | Loac ] Emvironmental ] Emvironrmental List E
@ nodel 5 T 53
. . Configuration Power System Health x
Navigation E::g::g Hosts |5 ~~ on (1 Total CPUs |1 [ Healthy s &
tree W noded y Enabled 14 0 ]
) masterhost Averaue - 4 a w
L& vomos: i | Provisioning 0 0 s
B
ke sed. ] J-10 ok =
Disk Free 12.3 GB z-+— Frame
| CPU Memory 7 tabs
1% Toral ?U%;cp“ Usel M 77% Used [
| Buser O 23% Free s
| O 0% Nice 0% 3
| [ s%system |
Docked 6170 wait
frame [ o5 Interrupts
[ 56 e nerrupts "
Time i User JE Image | Message | % |
Remove || ctear Enars
[ = Event Log 1 ‘}1] Provision Status
Frame tabs Upper pane Lower pane

Menus — A collection of pull-down menus that provide access to system features and functionality.
Tool Bar — The tool bar provides quick access to common tasks and features.

Frame Power On VCS Status

VCS Check In
|
-O@ B0 3

Power Off
Dashboards VCS

Host Compare

M- 0- & ~4

VCS Check Out

Server Name — The name of the server on which Cluster Manager is running.
System Tabs — Allow you to navigate and configure the cluster. Tabs may be opened, closed, and repositioned as
needed.
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Starting and Stopping the Cluster Manager Server

Frame Controls — Lets you dock, un-dock, hide, minimize, and close frames.
Auto-hide

Hide_‘ ’* Close

S

s Cluster
L &g ice?

saxoqad| B

Frames — Provide you with specific control over common aspects of cluster systems (for example, imaging and user
accounts). Each frame tab opens a frame containing a navigation tree that allows you to manage system components
easily. The navigation tree is found in most frames and is used to help organize cluster components. You may dock,
close, or relocate frames and frame tabs as needed.

Upper/Lower Panes — These panes allow you to view cluster information in a structured environment.

Starting and Stopping the Cluster Manager Server

Cluster Manager services are started and stopped from scripts in /etc/init.d. Cluster Manager is controlled by one of
these services — this allows you to manage Cluster Manager services using standard Linux tools such as chkconfig and
service. Standard functions for services include start, stop, restart, and status.

Example:

cd /etc/init.d; ./cmgr status
/etc/init.d/cmgr stop
/etc/init.d/cmgr start
chkconfig --list cmgr
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Verifying Cluster Manager Services are Running

Run the /etc/init.d/cmgr status command to verify that the following services are running:
- AuthenticationService
DHCPService
DNA .<host IP address>
DatabaseService
DistributionService.provisioning-00
DistributionService.provisioning-01

Cluster Manager includes two distribution services for each provisioning channel pair defined in the preferences.

FileService.<host name>
HostAdministrationService.<host name>
IceboxAdministrationService
ImageAdministrationService
InstrumentationService
KernelAdministrationService
LicenseAdministrationService
LogMonitoringService
NotificationService
PayloadAdministrationService
PayloadNodeService.<hostname>
PlatformManagementService
PowerMonitoringService
ProvisioningService
RemoteProcessService.<hostname>
RNA

- SynchronizationService

- TreeMonitoringService

- VersionService

- VersionService.<host_name>

10
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Chapter 2
Configuring ISLE Cluster Manager

Configure DHCP

If you are using Dynamic Host Configuration Protocol (DHCP) you need to configure it on your master host to ensure
proper communication with your compute nodes.

1. Inacommand line shell, log on as root.
2. Open /etc/sysconfig/dhcpd.
3. Look for the DHCPD_INTERFACE line and make sure it ends with ="ethx".
4. Replace “x” with the host interface you use.
Example:
DHCPD_INTERFACE=""eth0 ethl eth2"

5. Save and close the file.

Configure DHCP Settings

When provisioning occurs, Cluster Manager automatically modifies DHCP settings and restarts the protocol. If you
make manual DHCP modifications and want Cluster Manager to stop, start, restart, or reload DHCP, use the controls in
the DHCP menu.

When working with DHCP, ensure that the server installation includes DHCP and, if the subnet on which the cluster
will run differs from 10.0.0.0, edit the Network sub-class field in the preferences dialog.

The DHCP option of the Actions menu allows you to perform the following operations:

- Stop the DHCP server.

- Start the DHCP server.

- Restart the DHCP server.

- Reload the dhcpd.conf file.

Changes made to /etc/dhcpd.conf are overwritten when you provision the host.
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Configure Network and Email Settings

12

Configure Network and Email Settings

1
2.
3.

In the Cluster Manager interface, select Preferences from the Edit menu.
In the Preferences dialog, make sure the General button is selected.
In the Email Settings section, enter the sender, server, and domain information.
Use the email settings to send notifications of cluster events.
- Sender — Used as the “From” address.

- Server — Must be a valid SMTP server and must be configured to receive emails from the authorized domain.
- Domain — The domain used to send email.

Configure the network settings.
The network settings must be configured before provisioning the cluster for the first time. The base network sub-
class and netmask are mandatory. All other fields are optional.
- Base Network Sub-class — The private network used by the cluster (typically a 192.168.x.x or 10.X.x.X net-
work). To set the sub-class, the last octet should be a 0.
- Netmask — The subnet mask used in your cluster.
Log Server, NTP Server, Domain Name Server (DNS), and Default Gateway — Used to set up DHCP set-
tings. On a small to medium-sized system, these are typically the Master Host (by default, the log and NTP
servers are set to use the Master Host). The DNS and default gateway are not set by default, but you should set
them if you require all hosts to have external access to the cluster system.

Configure Preboot Execution Environment (PXE) Settings.

By default, Cluster Manager uses Etherboot as a scalable multicast boot client. When booting hosts that do not
have an Etherboot client, you can use PXE as a boot loader to load Etherboot. Once Etherboot is loaded, the hosts
will continue to boot or provision normally.

To configure hosts to use a PXE loader, you must install and configure a TFTP server. After installing and configuring
the TFTP server, open the preferences dialog from the Edit menu and browse to locate the zpxe-formatted PXE file —
Cluster Manager copies the file to the TFTP server’s root directory (typically,

[tftpboot). Commonly used zpxe files are available on the Cluster Manager ISO in the /misc directory. To obtain
additional Etherboot zpxe-formatted files, visit Etherboot’s ROM-O-Matic website, at

http://www.rom-o-matic.net. When downloading Etherboot files, select zpxe as the ROM type.

007-5513-003


http://www.rom-o-matic.net

Configure DHCP
Configure Users, Groups, and Roles

ROMs will not work with Multicast unless you add support for Scalable Local Area Multicast (SLAM). When
downloading the Etherboot files from http://www.rom-o-matic.net, do the following:

1. Under the customize ROM configuration step, click Configure. You are redirected to the
configuration page.

2. Select the DOWNLOAD_PROTO_SLAM option. This adds support for SLAM.

3. Click Back to return to the download page and finish downloading the Etherboot file.

To Set a Default PXE Boot File for All Hosts
A. Click Add to open the Add PXE Boot Entry dialog.
B. Select (default) from the drop-down list.
C. Enter the path of the “zpxe” file to use by default or browse to locate the file.
D. (Optional) Enable or disable the boot entry.
E. Click OK.
To Set a PXE Boot File for a Specific Host
A. Click Add to open the Add PXE Boot Entry dialog appears.
B. Select one of the configured hosts from the drop-down list.
C. Enter the path of the “zpxe” file to use by default or browse to locate the file.
D. (Optional) Enable or disable the boot entry.
E. Click OK.

6. Click OK to save the settings and close the Preferences dialog.

Configure Users, Groups, and Roles

Cluster Manager allows you to configure groups, users, roles, and privileges to establish a working environment on the
cluster.

A group refers to an organization with shared or similar needs that is structured using specific roles (permissions and
privileges) and region access that may be unique to the group or shared with other groups. Members of a group (users)
inherit all rights and privileges defined for the groups to which they belong.

Cluster Manager currently supports adding users and groups to payloads only — it does not support the management of
local users and groups on the Master Host. Users with local Unix accounts do not automatically have Cluster Manager
accounts, and this information cannot be imported into Cluster Manager.

If you are using local authentication in your payloads and intend to add Cluster Manager users or groups, make sure the
user and group IDs (UIDs and GIDs, respectively) match between the accounts on the Master Host and Cluster
Manager. Otherwise, NFS may not work properly.

13
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Default User Administration Settings

Cluster Manager creates the following default users, groups, and roles during installation:

¢ &3 Groups
&l guest
&1 power
&l root
5l users
7+ “ Roles

% root
& user

After installation, Cluster Manager allows you to create, modify, or delete groups, users, roles, and privileges as
needed.

You cannot remove the root user.

14
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Add a User

Adding a user to Cluster Manager creates an account for the user and grants access to the system.

1. Select New User from the File menu or right-click in the user navigation tree and select New User to open a new

user pane.
@ ISLE Cluster Manager - cwxhost
File Edit Yiew Actions Help
M- 0 &- 29 %%
M Configuration e Instrumentation " Provisioning
g Cluster -
% computehosts ~r cuthost | & New User ¢l |
W nodel User Name: joh |
@ node? ser Mame: john
:nndeB User ID: (1001 |
noded
45 masterhost Full Name: John Doe |
owxhost Password: e |
Confirm Password: [N |
Home Directory: | home,john |
Shell: { bin/bash =]
Groups [ ] Create a private group for the user lﬂi Add... Delete
Mame Crescription Primary
root Administrators fd
users Users v
[ | Disable Account Apply Close
[-5') Event Log ] [hj Provision Status 1

[ Buibew) g] [ saxogad| hl

2. Inthe User Name field, enter a login name.

3. (Optional) Enter changes to the system-generated ID in the User ID field.

4. In the Full Name field, enter the user’s first and last name.

The Cluster Manager UID must match the system UID.

5. Enter and confirm a new user password.

6. (Optional) Specify the user’s home directory in the Home Directory field (for example,

/home/username).

7. (Optional) Enter a shell for this user or click the drop-down menu to select an existing shell.

By default, Cluster Manager uses /bin/bash.

8. Click Apply.
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Define a User Group

The Groups pane allows you to identify the groups to which the user belongs. Users are allowed to be part of any
number of groups, but granting access to multiple groups may allow users unnecessary privileges to various parts of the
system.

1. To add the user to a group, click Add in the New User pane.
2. Select the groups to which you want to assign the user (use the Shift or Ctrl keys to select multiple groups).

Each user must belong to a primary group. If not, Cluster Manager automatically assigns the user to the “users” group.
If you are using third-party power controls such as IPMI, the power group must be the primary group for all users who
will use these controls.

3. Click OK to add the user to the groups.
4. (Optional) Click Create a private group for the user to create a new group with the same name as the user.

5. (Optional) Click Disable Account to prevent users from logging into this account.

Selecting this option also excludes this account from future payloads without requiring you to delete the account
from Cluster Manager.

Add a Group

Adding a group creates a collection of users with shared or similar needs (such as an engineering, testing, or
administrative group).

1. Select New Group from the File menu or right-click in the user navigation tree and select New Group to open
aNew Group pane.

Enter the group name.

2
3. (Optional) Enter changes to the system-generated group ID.
4. (Optional) Enter a description.

5

Click Apply.
ADD USERS
The Users pane allows you to identify the users that belong to the current group.
1. Click Add.
2. Select the users to add to the group.
3. Click OK.

ASSIGN ROLES
The Roles pane allows you to assign specific roles to the group.

1. Click Add.
2. Select the roles to assign to the group.
3. Click OK.

ASSIGN REGIONS
The Regions pane allows you to grant a group access to specific regions of the system.
1. Click Add.
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2. Select the regions to assign to the group.
3. Click OK.

Add a Role

Adding a role to Cluster Manager allows you to define and grant system privileges to groups.

1. Select New Role from the File menu or right-click in the Users frame and select New Role to open a New Role
pane.

2. Enter arole name.
3. (Optional) Enter a description.
4. Click Apply.

Adding or revoking privileges will not affect users that are currently logged into Cluster Manager. Changes take effect
only after the users close Cluster Manager and log in again.

ASSIGN GROUPS TO ROLES

The Groups pane allows you to assign a role to multiple groups. This permits users to have varied levels of access
throughout the system.

1. Click Add in the Groups pane.
2. Select the groups you want to assign to the role.
3. Click OK.

GRANT PRIVILEGES

The Privileges pane allows you to assign permissions to a role. Any user with the role will have these permissions in the
system.

1. Click Add in the Privileges pane.
2. Select the privileges you want to grant the current role.
3. Click OK.

Privileges

Privileges are permissions or rights that grant varying levels of access to system users. Cluster Manager allows you to
assign privileges as part of a role, then assign the role to specific user groups. Users assigned to multiple groups have
different roles and access in each group. This flexibility allows you to establish several types of roles you can assign to
users such as, Full Administration, Group Administration, User, or Guest.

17
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The following table lists the privileges established for the Cluster Manager module at the function and sub-function

levels:

Module Name Description

Cluster Manaager Database The ability to execute database commands from the command line.
Host The ability to configure Hosts, Regions, and Partitions.
Icebox The ability to configure Iceboxes.
Image The ability to configure Images, Payloads, and Kernels.
Instrumentation The ability to monitor the system.
Logging The ability to view and clear error logs.
Power The ability to manage power to hosts.
Provisioning The ability to provision hosts.
Serial The ability to use the Serial over LAN terminal.
User The ability to configure Users, Groups, and Roles.

18
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Chapter 3
Set Up Your Cluster

Clustered Environments

In a clustered environment, there is always at least one host that acts as the master of the remaining hosts (for large
systems, multiple masters may be required). The master host is reserved exclusively for managing the cluster and is not
typically available to perform tasks assigned to the remaining hosts.

To manage the remaining hosts in the cluster, you can divide them into partitions and regions.
Partitions include a strict set of hosts that may not be shared with other partitions.

Regions are a subset of a partition and may contain any hosts that belong to the same partition. Hosts contained within a
partition may belong to a single region or may be shared with multiple regions. Dividing up the system can help
simplify cluster management and allows you to enable different privileges on various parts of the system.

Add a Host

To add a host, you must provide the host name, description, MAC address, IP address, and the partition and region to
which the host belongs. Hosts can be added only after you have set up a Master Host.

You can also import a list of existing hosts. See Import Hosts on page 25.

1. Select the Cluster icon in the Hosts frame.
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2. Select New Host from the File menu or right-click in the host navigation tree and select New Host.
A new host pane appears.

m ISLE Cluster Manager - cwxhost -
File Edit Yiew Actions Help
- 0O- [&- a i =
o = Configuration b Instrumentation ™3 Provisioning 4k BEx
= Cluster
% computehosts |~~~ New Host (1) [~ nacied |
W nodel Name: | I
W node2 # InodeS
W nodes Description: | |
W noded .
% masterhost Partition: |cnmputehnsts |'|
owxhost
Interfaces Fdit.. 58 Add.. Delete Regions of Add... Delete
| Address | Managernent | Mame Description |
00:34:8C:0A:2FEF  [10.1.0.105 |
Platform Management
) Use Global Settings ‘® Override Global Settings
Management Device 1: Icebox Management Device 3: <None:
Use Device 1 For Power EBeacon Use Device 3 For: || Power [] Beacon
Environmental [v||Console [] Environmental [] Console
Management Device 2: <None:
Use Device 2 For: || Power []EBeacon
[] Environmental [] Console
[-f-’ Event Log 1 [hj Provision Status 1

I s1asf ?I I Buibew| !,I I sax0qal) ‘}

3. Enter the host name.

(Optional) Enter a description.
(Optional) Select the name of the partition to which this host belongs from the drop-down menu.

If you right-click a partition of region in the navigation tree and select New Host, the host is automatically assigned to

that partition or region.

6. Create Regions and

Interfaces assignments as needed.

7. Click Apply to create the new host.
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Add Interfaces
The Interfaces pane allows you to create new interfaces and assign host management responsibilities.

1. Inthe Interfaces pane, click Add.
The New Interface dialog appears.

= NewInterface ® |

MAC: 00:45:E1:56:01:EE
Address: (10 . 2 . 0 ,105

Management: |¥

OK Cancel

2. Enter the host’s MAC and IP addresses.

To find the MAC address of a new, un-provisioned host, you must watch the output from the serial console. Etherboot
displays the host’s MAC address on the console when the host first boots. For example:

Etherboot 5.1.2rc5.eb7 (GPL) Tagged ELF64 ELF (Multiboot) for EEPRO100]
Relocating _text from: [000242d8,00034028) to [17fdc2b0,17fec000)

Boot from (N)etwork (D)isk (F)loppy or from (L)ocal?

Probing net...

Probing pci...Found EEPRO100 ROM address 0x0000

[EEPRO100]Ethernet addr: 00:02:B3:11:03:77

Searching for server (DHCP)...

(*1f conman is set up and working, this information is also contained in the conman log file for the host—typically
located in /var/log/conman/console.n[1-x])

To find the MAC address on a host that is already running, enter ifconfig -a in the CLI and look for the HWaddr of
the management interface.

3. Click Management to use the Cluster Manager interface to manage the host.
Cluster Manager stores the interface and automatically writes it to dhcp.conf.
4. Add any additional interfaces required for this host.
Cluster Manager records the interfaces and writes them to dhcpd.conf.

If you are using IPMI or another third-party power controller, you should add the BMC’s MAC address and the IP
address you are going to assign it. Cluster Manager will set up DHCP to connect to the BMC. In the Platform
Management settings, you can select this interface and use it for operations.

5. Click OK.

21
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Assign Regions
The Regions pane allows you to identify any regions to which the host belongs.
1. (Optional) In the Regions pane, click Add.
The Select Regions dialog appears.
. Select the region to which the host belongs. (To select multiple regions, use the Shift or Ctrl keys.)
3. Click OK.

Configure Platform Management

Platform management allows you to configure the power and temperature Management Devices you will use for each
host.

By default, platform management uses the device specified in your Global preferences settings to control hosts in the
cluster. To override this setting, select Override Global Settings.

IPMI

Typically, hosts use one or more Ethernet interfaces. With IPMI, ILO, and DRAC, each host uses at least two
interfaces: one management interface and one IPMI/ILO/DRAC interface. The management interface is configured for
booting and provisioning, the IPMI/ILO/DRAC interface is used to gather environmental and sensor data (for example,
fan speeds) from the host and perform power operations. Additional interfaces are used only for setting up host names
and IP addresses.

ILO and DRAC support power control only — they do not support temperature and sensor monitoring.

In order for Platform Management to work correctly, you must first define interfaces for each host (see Add Interfaces
on page 21). In some cases, you must manually configure an IP address for the Platform Management Controller—in
most cases, however, you can use DHCP to configure this address. To view information about each interface, see
dhcpd.conf.

The IPMI dialog defines which interface is used for Platform Management. Typically, the Management Device is easily
identified because its MAC or IP address is an offset of the host. For example, a host with a MAC address of
00:11:22:33:44:56 and an IP address of 10.0.0.1 might have a Management Device with a MAC address
00:11:22:33:44:59 and set an IP address of 10.0.2.1. In this case, the MAC offset would be 000000000003 (Greater)
and the IP offset would be 0.0.2.0 (Greater).
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To CONFIGURE IPMI SETTINGS ON YOUR HOST

1. Select Override Global Settings.

2. Select IPMI from the Platform Management Device Type drop-down list.
Platform Management Device Type: [IPMI -

Management Device IP Address Type: Dynamic |«

MAC Address vs Host MAC Address: Greater Than |«

MAC Address Offset: O0:00:00:00:00:04

Platform Management User admin |«

Ok Cancel

3. Select the Management Device IP Address Type:

A. Dynamic — Enter a hexadecimal MAC offset. For example, if you choose a Greater Than offset of
00:00:00:00:00:04 and the host’s MAC address is 00:15:C5:EA:A7:7B, the MAC Address used for power
operations will be 00:15:C5:EA:A7:7F (the sum of the original MAC address and the offset).

B. Relative — Choose an IP address offset and select whether it is Greater Than, the Same As, or Less Than
the host’s IP address. For example, if you choose a Greater Than offset of 0.0.1.0 and the host’s IP address is
10.3.0.14, the host’s BMC address will be 10.3.1.14. This is the IP address used for power operations (the
sum of the original IP address and the offset).

C. Static — If you choose Static or if you wish to use different settings for each host, you must configure the
IPMI options individually for each host.

4. (Optional) Select the MAC Address vs. Host MAC Address type:
A. Not Related
B. Greater Than
C. Less Than

(Optional) Enter the MAC Address Offset.
Select the MAC Address to use to manage this host.

(Optional) Select the IP Address vs. Host IP Address type:
A. Greater Than

B. Less Than
C. Same As

8. (Optional) Enter the IP address offset from the management interface.
9. (Optional) Enter the IP address for the host.
10. Select a Platform Management User.

Users must belong to Power as their primary group to appear in this list.

23

007-5513-003



Clustered Environments
Configure Platform Management

DRAC and ILO

1.
2.

Select Override Global Settings.
Select DRAC or ILO as the Platform Management Device Type.

'-- Management Device 1 Settings x N

Platform Management Device Type: |DRAC -

Management Device IP Address Type: |Relative @«

IP Address vs. Host IP Address:  Greater Than |«

IP Address Offset: | 0 . 0 . 1 ., 0

Platform Management User: |admin | w

Ok Cancel

3. Select the Management Device IP Address Type:

8.
9.

A. Dynamic — Enter a hexadecimal MAC offset. For example, if you choose a Greater Than offset of
00:00:00:00:00:04 and the host’s MAC address is 00:15:C5:EA:A7:7B, the MAC Address used for power
operations will be 00:15:C5:EA:A7:7F (the sum of the original MAC address and the offset).

B. Relative — Choose an IP address offset and select whether it is Greater Than, the Same as, or Less Than the
host’s IP address. For example, if you choose a Greater Than offset of 0.0.1.0 and the host’s IP address is
10.3.0.14, the host’s BMC address will be 10.3.1.14. This is the IP address used for power operations (the
sum of the original IP address and the offset).

C. Static If you choose Static or if you wish to use different settings for each host, you must configure the
DRAC and ILO options individually for each host.

(Optional) Select the MAC Address vs. Host MAC Address type:

A. Not Related

B. Greater Than

C. LessThan

(Optional) Enter the MAC Address Offset.
Select the MAC Address to use to manage this host.

(Optional) Select the IP Address vs. Host IP Address type:
A. Greater Than
B. Less Than
C. Same As

(Optional) Enter the IP address offset from the management interface.
(Optional) Enter the IP address for the host.

10. Select a Platform Management User.

Users must be members of the Power group to appear in this list.
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Import Hosts

Cluster Manager provides an easy way to import a large group of hosts from a file. When importing a list of hosts, it is
important to note that Cluster Manager imports only host information. Cluster Manager accepts the following file types:
nodes.conf, dbix, or CSV.

To Import a List of Hosts

1. Obtain or create a host list file for importing. The following examples depict nodes.conf, dbix, and CSV file
formats:

A. nodes.conf

SGI1 nodes.conf format lists one host per line with properties being space or tab
delimited:
MAC HOSTNAME IP_ADDRESS BOOT_MODE UNIQUE_NUM DESCRIPTION

Example:
0050455C0392 n001 192.168.4.1 boot_mode 1 Node_n001l1
0050455C03A2 n002 192.168.4.2 boot_mode 2 Node_n002

B. dbix

dbix

hosts.<hostname>.description: <description>
hosts.<hostname>_enabled:true
hosts.<hostname>.name:<hostname>
hosts.<hostname>.partition:<partition>
interfaces.<MAC_addressl>_address:<IP_addressl>
interfaces.<MAC_addressl>._mac:<MAC_addressl>
interfaces.<MAC_addressl>_management:true
interfaces.<MAC_addressl1>.owner:<hostname>
interfaces.<MAC_address2>.address:<IP_address2>
interfaces.<MAC_address2>.mac:<MAC_address2>
interfaces.<MAC_address2>_management:false
interfaces.<MAC_address2>.owner :<hostname>

Example:

hosts.nl.description:Added automatically by add_hosts.shasd
hosts.nl.enabled:true

hosts.nl.name:nl
hosts.nl.partition:computehosts
interfaces.0030482acc96.address:10.0.1.1
interfaces.0030482acc96.mac:0030482acc96
interfaces.0030482acc96.management:true
interfaces.0030482acc96.owner:nl
interfaces.0030482acc9a.address:10.0.2.1
interfaces.0030482acc9a.mac:0030482acc9a
interfaces.0030482acc9a.management: false
interfaces.0030482acc9a.owner:nl

Dbix files are created primarily by obtaining and editing a Cluster Manager database file.

25
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C. Csv
HOSTNAME ,MAC_ADDRESS1, IP_ADDRESS1,DESCRIPTION,MAC_ADDRESS2, IP_ADDRESS2

Example:
nl4,”0040482acc96,0040482acc9a,”10.4.1.1,10.4.2.1" ,Description

2. Select Import Host List from the File menu.
The Host List Import Utility dialog appears.

o Host List Import Utility x

File Type:|Cluster Host List thodes.conf -
File Path: | root/ nodes.conf il
Status | Import Host MAC IF Description

o v nodel 00:0c29:70:ccas  (10.1.0.101

o v node2 00:0c29:de;>4:a6 (10.1.0.102

l{',: v node3 00:0c2%4d:cic8  |10.1.0.103

l{',: v noded 00:0c29:2a22:2f |10.1.0.104

Clear Import Close

3. Select the host list file type you are importing.
If you change the file type, click Refresh to update the dialog.

Enter the path for the file you want to import or click Browse to locate the file.

Review the list of hosts to import and un-check any hosts you do not want.
Errors display for items that cannot be imported.

To clear the list of selected hosts, click Clear.

6. Click Import to import the list of hosts.
7. Click Close.

Add Partitions

Partitions are used to separate clusters into non-overlapping collections of hosts. Hosts that belong to a partition may
not be used by anyone who is not authorized to access the partition. Within a partition, host access may be shared
between regions of users.

26
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To Add a Partition

1.

Select New Partition from the File menu or right-click in the host navigation tree and select New Partition.
A new partition pane appears.

Enter a partition name.

(Optional) Enter a description.

In the Regions pane, click Add.
The Select Regions dialog appears.

This dialog displays only regions that are not already assigned to a partition.

5
6.
7.
8

Select regions you want to include in this partition and click OK.
In the Hosts pane, click Add to display the Select Hosts dialog.
Select a hosts to add to this partition and click OK.

Click Apply.

Create Regions

A region is a subset of a partition and may share any hosts that belong to the same partition — even if the hosts are
currently used by another region. Adding regions allows you to more closely allocate resources to specific groups and
users.

To Create a Region

1.

Select New Region from the File menu or right-click in the host navigation tree and select New Region.

A new region pane appears.

Enter a region name.

(Optional) Enter a description.

(Optional) From the drop-down list, select the name of the partition to which you want to assign the region.

Regions not assigned to a partition become part of the default or unassigned partition.

5.

From the Hosts pane, click Add to assign a hosts to the region.
The Select Hosts dialog appears.

Select the hosts you want to add to the region.
Click OK.

From the Groups pane, click Add.
The Select Groups dialog appears.

Select the groups you want to add to the region.
Adding groups to the region defines which users may access the hosts assigned to the region.

10. Click OK.
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If you forget to assign groups to the region, the hosts appear to be non-existent.

11. Click Apply.
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Creating Payloads and Images

Payload Management

Payloads are stored versions of the operating system and any applications installed on the hosts. Payloads are
compressed and transferred to the hosts via multicast during the provisioning process.

Configuring a Payload Source

Before you can build a new payload, you must have a package source available for use. A package source can be the
RHEL or SLES physical media, 1SO media, ftp or http install, or media copied to your hard drive.

Physical Media

If you are using physical media, you must insert it and mount it for your CDROM:

/mnt/cdrom
or
/media/dvd

CD ISOs
If you are using the CD 1SOs, you must mount the ISOs one at a time to simulate using the CDROM:

mount -o loop <ISO_name> <mount_point>

Using either the multiple disks or multiple 1SOs may require switching between disks several times.

DVD ISOs

DVD ISOs are perhaps the most convenient because they are simply mounted and do not require changing disks. To use
aDVD ISO:

mount -o loop <ISO_name> <mount_point>

FTP or HTTP

You must follow the operating system vendors recommendations for setting up a network based installation. Some
problems have been reported using Apache 2.2.
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Copying the Media

If you have CD media or CD 1SOs and will be creating multiple payloads or requiring additional packages following
payload creation, it is worthwhile to copy the distribution to the hard drive. See Red Hat Installations below or SUSE
Linux Enterprise Server Installations on page 30 for instructions on how to copy the installation disks for your
distribution.

RED HAT INSTALLATIONS

If you choose to copy the entire contents of each disc rather than the files described below, you must copy discl LAST.
Failure to copy disks in the correct order may produce payload creation failures (for example, package aaa_base may

not be found).

1. Mountdisk 1 and copy the contents of the entire disk to a location on the hard drive:
mount /mnt/cdrom

or
mount -o loop RHEL-x86_64-WS-discl.iso /mnt/cdrom
mkdir /mnt/redhat

cp -r /mnt/cdrom/* /mnt/redhat

2. Mount disk 2 and copy the *.rpm files from the RPMS directory to the RPMS directory on the hard drive:
cp /mnt/cdrom/RedHat/RPMS/*_rpm /mnt/redhat/RedHat/RPMS

3. Mount each remaining disk and copy the RPMS directory to the RPMS directory on the hard drive.
SUSE LINUX ENTERPRISE SERVER INSTALLATIONS

If you choose to copy the entire contents of each disc rather than the files described below, you must copy discl LAST.
Failure to copy disks in the correct order may produce payload creation failures (for example, package aaa_base may

not be found).

1. Mount disk 1 and copy the contents of the entire disk to a location on the hard drive:

mount /media/cdrom

or
mount -o loop SLES-9-x86-64-CD1.iso /media/cdrom
mkdir /mnt/suse

cp -r /media/cdrom/* /mnt/suse

2. Mount disk 2 and copy the RPMs from each architecture subdirectory to the SUSE directory on the hard drive:

cp -r /media/cdrom/suse/noarch/* /mnt/suse/suse/noarch
cp -r /media/cdrom/suse/i586/* /mnt/suse/suse/i586

cp -r /media/cdrom/suse/i686/* /mnt/suse/suse/i686

cp -r /media/cdrom/suse/src/* /mnt/suse/suse/src

cp -r /media/cdrom/suse/nosrc/* /mnt/suse/suse/nosrc
cp -r /media/cdrom/suse/x86_64/* /mnt/suse/suse/x86_64

3. Mount each remaining disk and copy the RPMs from each architecture subdirectory to the SUSE directory.
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Create a Payload

Payloads are initially created using a supported Linux distribution installation media (CD-ROM, FTP, NFS) to build a
base payload (see Operating System Requirements on page 2 for a list of supported distributions) or by importing a
payload from a previously provisioned host. Additions and changes are applied by adding or removing packages, or by
editing files through the GUI or CLI. Changes to the Payload are managed by the Cluster Manager Version Control
System (VCS). Package information and files are stored and may be browsed through Cluster Manager.

Please consult SGI before upgrading your Linux distribution or kernel. Upgrading to a distribution or kernel not
approved for use on your system may render Cluster Manager inoperable or otherwise impair system functionality.
Technical Support is not provided for unapproved system configurations.

To Create a New Payload
To create a new payload from a Linux distribution, do the following:
1. Select New Payload from the File menu or right-click in the imaging navigation tree and select New Payload.

sl ISLE Cluster Manager - cwxhost

File Edit Yiew Actions Help

- M- &- CRE B

4 masterhost
L & cwxhost

Source: Tile:jtmpf mnty

Select...

Cl. Configuration b Instrumentation 9 Provisioning 4 b E X ﬂ ’
g Cluster Payloads =
L] computehosts [v Mews Host (1) ]V noded ] i New Payload (1) E “* Kernels 5
@ nodel Al Images 2
@ node2 Name: |sles-10 Advanced ~ o 9 &
*
W nodes Description:
W noded

-
[+

s1as)

Architecture: | x86_64 -

Distribution: SuUSE Linux Enterprise Server 10.2 x86_64)

Packages b Add.. 3 Delete

Yiew by: | Category - Package Information

- '-1.'] Server Base System -
|- @ OpenIPMI-2.0.13-17.4 =
|- {3 SPident-0.9-74.23

|- @ SusEfirewall2-3.4_S¥Nr142-7.10

|- {3 aaa_base-10-12.46

|- & aaa_skel-2006.5.19-0.3

- ac-2.2.41-0.12

- & acpid-1.0.4-20.9

-4 ash-1.6.1-15.2

-4 at-3.1.8-921.21

- attr-2.4.34-0.7

|- @ audit-libs-1.2.9-6.17

|- 1 autofs-4.1.4-23.21

|- & autoyasi2-2.13.101-0.3

— ‘ii autoyast?-installation-2.13.101-0.3
|- % bash-3.1-24.14

- 1 bc-1.06-764.2

|- ‘& bind-libs-9.3.4-1.23

I & bind-utils-9.3.4-1.23

‘r_ﬂ_hmunls_ﬂ.ﬁl.ﬂ.l_ﬂﬁ_ﬂ_ll_‘ 3

Apply Close

[® EvemtLog | [k Provision Status |

A new payload pane appears.
Enter the name of the new payload in the Name field.

(Optional) Enter a description of the new payload in the Description field.
Click Select to display the Package Source dialog.

o &~ b

From the Scheme drop-down list, select file:, http://, or ftp://.
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6. If you select the file: scheme, click Browse to locate the Linux distribution you want to use. Otherwise, enter the
URL or FTP address of the Linux distribution you want to use.

If you are creating multiple payloads from the same distribution source, it may be faster and easier to copy the
distribution onto the hard drive. This also prevents you from having to switch CD-ROMs during the payload creation
process. See Red Hat Installations on page 30 and SUSE Linux Enterprise Server Installations on page 30 for specific
details on installing these distributions.

(Optional) Enter a Host (only if the selected scheme is http:// or ftp://).
(Optional) Enter Username and Password (only if you selected Use Authentication).
Click OK to continue.

10. As the distribution loads, the Task Progress dialog appears. This dialog displays the payload creation status and
identifies any errors that occur during the load process.

IF | Task Progress x

Load Distribution

v| Hide on completion Cancel
Qperation | Status Messages

Read %  Loading package information

Create «"  SE Linux disable check

Read %  Detecting distribution architecture

Read ¢ Reload distribution using detected architecture

Read =  Reload distribution configuration scripts

Create %  Found Supported Distribution

Show only errors

Select Hide on Completion to close the Task Progress dialog if no errors or warnings occur.

If Cluster Manager is unable to detect payload attributes, the Distribution Unknown dialog appears. From this dialog,
select the distribution type that most closely resembles your distribution and Cluster Manager will attempt to create
your payload.

11. (Optional) In the packages pane, click Add to include additional packages in the payload.
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The Select Packages dialog appears.

.-- Select Categories = b
Gelect All
Category Mame Description

32Bit Runtime Environment |This will install the 32bit variant of..| ~|
Basis-Devel-32bit
C/C++ Compiler and Tools Minimal set of tools for compiling ...
Common Code Ease Consists of all packages that are co...
DHCP and DNS Server Set up the server for the Dynamic H...
Default System This is the default system for this ..
Directory Server (LDAP Set up a directory server with Open...
Documentation This is the documentation for the N...|=
Documentation-32bit
File Server Set up a file server to host files so ..
GMOME Desktop Environme... The GNOME desktop environment i...
High Availability Provide tools to ensure a high degr...
Internet Gateway Set up a proxy, firewall, and gatewa...
KDE Desktop Environment ... KDE is a powerful free software gra.. |
Laptop
Laptop- 32bit
Mail and MNews Server Set up electronic mail and message...
Minimal System (Appliances) This is the minimal Novell SUSE Lin...
Minimal- 32bit
Movell AppArmor Movell AppArmor is an open source...
Oracle Server Base Set up the server for installing Orac..
Print Server Set up a print server to host print q...
SAP Application Server BEase Set up the server for installing SAP ..
WEEM- 32hit
Web and LAMP Server Set up a Web server that is ableto .. |~

12. Select which payload categories to install or remove by clicking the checkbox next to each package.

When you select a “core” category to include in a payload, Cluster Manager automatically selects packages that are
essential in allowing the capability to run. However, you may include additional packages at any time.

13. Click OK to continue.

14. (Optional) From the Packages pane, select packages you want to remove from the payload, then click Delete in the
packages pane.

15. (Optional) Configure any advanced settings you want to apply to the payload.

16. Click Apply to save changes and build the payload.
The payload progress dialog appears.

If an RPM installation error occurs during the payload creation process, Cluster Manager enables the Details button and
allows you to view which RPM produced the error.

To view error information about a failed command, click the command description field. You may copy the contents of
this field and run it from the CLI to view specific details about the error.

17. (Optional) Select any payload files you wish to include with, remove from, or edit from the File drop-down menu.
18. (Optional) Click Check In to import the new payload into the Version Control System (VCS).
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Install Cluster Manager into the Payload

When working with payloads, Cluster Manager requires that each payload contain some basic Cluster Manager
services. These services allow Cluster Manager to control various parts of the system, including instrumentation
services and the monitoring and event subsystem.

There are two ways to install Cluster Manager into a payload: through the Cluster Manager installer or by adding RPMs
included on the Cluster Manager 1SO ($CMHOME/rpms) to the payload. The Cluster Manager installer assumes that
the payload uses the same OS and architecture as the Master Host. If you are trying to support a different OS or
Acrchitecture (32 or 64-bit), use the RPMS on the Cluster Manager I1SO. The 1SO includes several Cluster Manager and
Cluster Manager-Java RPMS, so you must select the RPMs that match your OS and architecture.

By default, RPMs use host as the Master Host in the @genesis.profile file. You must change this to match the name of
your Master Host or make sure host can be resolved through the /etc/hosts file or DNS. If you change the
system.rna.host in the @genesis.profile, you must also change the Transmitter Address in
$CMHOME/etc/InstrumentationService.profile.

To Install Cluster Manager into the Payload
1. Access the payload’s root directory:
cd $CMHOME/ imaging/<username>/payloads/<payload>/

2. Run the install script from the Cluster Manager Installation:
/mnt/cdrom/install_sh

3. Inthe Cluster Manager Installer, select Payload.

'spi ISLE Cluster Manager Installer

sgl  ISLE Cluster Manager

Please select an installation type.

ISLE Cluster Manager Server
— The master host of the cluster. This installs all services necessary for ISLE Cluster

E Manager to work properhy. Choose this type if you are configuring the cluster and
@ hawe administrative access

Client
The ISLE Cluster Manager graphical user interfaces without any services or additional
configuration. The client install can be used on Windows or Linux. Choose this type if
wou are not the Cluster Admministrator or don't hawve administrative access on the
cluster

o Payioad

The basic set of services that run an a host in arder to be used within ISLE Cluster
Manager. MOTE: The installer must be run from the root of the pavioad. Choose this
type if ywou are configuring the hosts on the cluster and have administrative access on
the cluster.

Installation Directory: |foptfows Browse

ISLE Cluster Manager Server |sleslo

= Back MNext > Cancel

4. Enter the name of the Cluster Manager Server.

The Cluster Manager Server must be a valid host name that can be resolved through name resolution (using DNS or the
letc/hosts file).

007-5513-003



Kernel Management
Install Cluster Manager into the Payload

If the hosts will communicate with one another, you may prefer to use host names (such as, nodel, node2, node3 and so
on) rather than IP addresses. Hosts use “name resolution” to convert between numbers and names — most commonly

through a local /etc/hosts file or with DNS.

For typical Cluster Manager users, the local /etc/hosts file already exists on the Master Host computer. To make this file
available to all hosts, copy the file into the payload (or simply edit the file in the payload). If you need to create this file,
use the dbx command to create an /etc/hosts formatted list of the hosts in your cluster. To save this list, redirect the
output to a file:

dbx -f:hosts

Enter the installation directory (for example, /opt/sgi/islecm).
Click Next.
Review the installation settings and click Install to continue.

© N o v

After the installation completes, click Finish.

Kernel Management

Kernels may be customized for particular applications and used on specific hosts to achieve optimal system
performance. Cluster Manager uses VCS to help you manage kernels used on your system.

To Create a Kernel Using an Existing Binary

For information on building a new kernel from source, see Building a New Kernel from Source on page 37.

1. Select New Kernel from the File menu or right-click in the imaging navigation tree and select New Kernel.

ISLE Cluster Manager - cwxhost

File Edit View Actions Help

-0 & a 3
[¥ Configuration l& Instrumentation ' Provisioning bk [ &
s Cluster Wl Payloads i,
4 computehosts £ New Kernel 1) E “ Kemels 2
W nodel 1 <
@ node? Name: [sles-10 4 images &
W node3 Description:
@ noded
45 masterhost (2]
&. caxhost
- Architecture: |x86_64 - E
b
Kernel Binary: |/ boot/vmlihuz-2.6.16.21-0.8- default ol
Modules directory: |/lib/ modules; 2.6.16.21- 0.8- default

Apply Revert Close

) EventLog | [@ Provision Status
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Enter the kernel name.
(Optional) Enter a kernel description.
Select the hardware architecture.

o~ DN

Enter the full path to the kernel binary you want to use, or click Browse to find the kernel binary you want to use.

Make sure you select a kernel binary that begins with vmlinuz and not vmlinux. Selecting vmlinux will result in
provisioning problems later on.

Ir | Remote File Chooser - cwxhost X
Look in: | ] boot - @ (& (] ([
. =] message

] boot [E] symsets-2.6.16.21- 0.8- defaulLtar.
J grub [E] symtypes-2.6.16.21-0.8- default.g;
[5] System.map-2.6.16.21-0.8-default  [2] symvers-2.6.16.21-0.8- default.gz
= backup_mbr [E vmlinux-2.6.16.21- 0.8- defaultgz
[5] config-2.6.16.21-0.8- default [Z] vmlinuz

[Z] initrd [E] vmlinuz-2.6.16.21-0.8- default

[E] initrd-2.6.16.21- 0.8 - default

1| i ] T»

File Name: vmlinuz-2.6.16.21-0.8-default

Files of Type: |Einary file selection -

Open Cancel

6. Click Browse to find the modules directory and click Open.
7. Click Apply to create the kernel.
8. (Optional) Click Check In to import the kernel into VVCS.

To Create a Copy of an Existing Kernel

1. Right-click on an existing kernel in the Imaging navigation tree and select Copy.

You may also open a kernel for editing, then click the Copy button in the panel.

2. Inthe Copy Kernel dialog, enter a name for the new kernel.

Copy Kernel - sles-10¢0)

MNew name |sles-10.u2

0K Cancel

3. Click OK.
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Building a New Kernel from Source

If you want to use a stock vendor kernel already loaded on your system, see To Create a Kernel Using an Existing
Binary on page 35. Otherwise, use the following procedure to build a new kernel from source:

Please consult SGI before upgrading your Linux distribution or kernel. Upgrading to a distribution or kernel not
approved for use on your system may render Cluster Manager inoperable or otherwise impair system functionality.
Technical Support is not provided for unapproved system configurations.

1. Obtain and install the kernel source RPM for your distribution from your distribution CD-ROMs or distribution
vendor.

This places the kernel source code under /usr/src, typically in a directory hamed
linux-2.<minor>.<patch>-<revision> (if building a Red Hat Enterprise Linux kernel, Cluster Manager places the
source code into /usr/src/kernels/2.<minor>.<patch>-<revision>).

Because you don’t need the kernel source RPM in your payload, install the RPM on the host.

2. If present, review the README file inside the kernel source for instructions on how to build and configure the
kernel.

It is highly recommended the you use, or at least base your configuration on one of the vendor’s standard kernel
configurations.

w

Typically, a standard configuration file is installed in the /boot directory, usually as
config-2.<minor>.<patch>-<revision>.

You may also use a stock configuration file installed as .config in the kernel source directory or available in a sub-
directory (typically /configs) of the kernel source directory.

To use a stock configuration, copy it to the kernel source directory and run:
make oldconfig.

4. Build the kernel and its modules using the make bzlImage && make modules command.

If your distribution uses the Linux 2.4 kernel, use make dep && make bzlmage && make modules but DO
NOT install the kernel.

From the File menu, select Source Kernel.

In the New Kernel panel, enter the name of the kernel.
(Optional) Enter a description of the kernel.

Select the hardware architecture.

© ©® N o g

Enter the location of the kernel source (the directory where you unpacked the kernel source) in the Source
Directory field or click Browse to find the source directory and click Open.

By default, kernel source files are located in /usr/src.
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10. (Optional) Enter the binary path of the kernel (for example, arch/i386/boot/bzimage) or click Browse to find the
kernel and click Open.

11. Select the modules directory and click Open.

12. Click Apply to create the kernel.

13. (Optional) Click Check In to import the kernel into VCS.

Image Management

Images contain exactly one payload and one kernel, and allow you to implement tailored configurations on various
hosts throughout the cluster.

Please consult SGI before upgrading your Linux distribution or kernel. Upgrading to a distribution or kernel not
approved for use on your system may render Cluster Manager inoperable or otherwise impair system functionality.

Technical Support is not provided for unapproved system configurations.

Create an Image

To Create an Image
1. Select New Image from the File menu or right-click in the Imaging navigation tree and select New Image.

ISLE Cluster Manager - cwxhost
Eile Edit Yiew Actions Help
0a-m-E- A3 | -
— Configuration lad Instrumentation " Provisioning N - Imaging &A%
ue® Cluster i Payloads
45 computehosts Wl sles-10 | © sles-10 | 4@l New Image (1> [ ﬁ sles-10 ¢0)
nodel - * Kernels
:nudeZ Marme: [sles-10 RAM Disk... Advanced... [ +* sles-10¢0)
node3 intion: “#l Images
Description:
@ noded
45 masterhost [ 2
& owxhost =
Architecture: x86_64 - 2
7
Payload: sles-10, 0 'lj
Kernel: sles-10, 0
Partitions P Add...
Device Size FS Tywpe Mount Point Format
Check In... Apply Revert Close
I\J Event Log ] [BJ Provision Status I

2. Enter a name in the Name field.
3. (Optional) Enter a description in the Description field.
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Select the architecture supported by the kernel.
Click the Browse folder icon to select a Kernel.
Select the Browse folder icon to select a Payload.

Define the partition scheme used for the compute hosts — the partition scheme must include a root (/) partition. See
To Create a Partition for an Image on page 41.

Kernel support for selected file systems must be included in the selected kernel (or as modules).

N o g oM

(Optional) Implement RAID. See Managing Partitions on page 41.

(Optional) If you need to make modifications to the way hosts boot during the provisioning process, click the RAM
Disk tab.

10. (Optional) Click the Advanced button to display the Advanced Options dialog.
This dialog allows you to configure partitioning behavior and payload download settings (see Advanced Imaging
Options).

11. Click Apply.

Advanced Imaging Options

The Advanced Options dialog allows you to configure partitioning behavior and payload download settings. These
settings are persistent, but may be overridden from the Advanced Provisioning Options dialog.

Ir | Advanced Options X b

Partitioning behavior

* [Automatid

Always repartition
Mever repartition
Payload download

® Automatic
Always download

Never download

Apply Cancel

PARTITIONING BEHAVIOR

This option allows you to configure the partition settings used when provisioning a host. You may automatically
partition a host if the partitioning scheme changes, always re-create all partitions (including those that are exempt from
being overwritten), or choose to never partition the host. See Managing Partitions on page 41.

PAYLOAD DOWNLOAD

The payload options allow you to automatically download a payload if a newer version is available (or if the current
payload is not identical to that contained in the image), always download the payload, or choose to never download a
payload.
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boot.profile

Cluster Manager generates the boot.profile file each time you save an image (overwriting the previous file in /etc/
boot.profile). The boot profile contains information about the image and is required for the boot process to function
properly. You may configure the following temporary parameters:

dmesg.level The verbosity level (1-8) of the kernel — 1 (the default) is the least verbose and 8 is the
most.

partition Configure the hard drive re-partitioning status (Automatic, Always, Never). By default,
Automatic.

partition.once Override the current drive re-partitioning status (Default, On, Off). By default, Default.

image Configure the image download behavior (Automatic, Always, Never). By default,
Automatic. Always and Never will download the image even if it is up-to-date.

image.once Override the current image download behavior (Default, On, Off). By default, Default.
To view the current download behavior, see Advanced Imaging Options on page 39.

image.path Specifies where to store the downloaded image. By default, /mnt.

To change the configuration of one of these parameters, add the parameter (for example, dmesg.level: 7) to the
boot.profile and provision using that image. You may also configure most of these values from the GUI. See Select an
Image and Provision on page 43.

Changes made to image settings remain in effect until the next time you save the image.
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Managing Partitions

To Create a Partition for an Image

1.

2.

3.

4. Enter the device on which to add the partition or select a device from the drop-down list. Supported devices include
the following, but the most common is /dev/hda because hosts typically have only one disk and use IDE:

Right-click an existing image in the Imaging navigation tree and select Edit.

'spi ISLE Cluster Manager - cwxhost —O0x
File Edit Yiew Actions Help
a-0-E- RO 30
o — Configuration kd Instrumentation ™5 Provisioning 4 b B8 x W '
ag® Cluster Payloads -
5 computehosts @ sles-10 | F sles-10 | A New Image @) | L @i stes-10¢0) ||| 2
nodel F Kernels ]
@ node? Name: [sles-10 | | Ram pisk.. || | Lo stes-10¢0y ||| 3
W node3 - -'il’r’na
Description: . ges
@ noded v
‘) masterhost 62
owxhost =]
Architecture: |xB6_64 [~] g
-
Payload: |s|esfltl, o
Kernel: |s|esfltl, o
Partitions RAID Options... Edit... &8 Add... Delete
Device Size FS Twpe Mount Point Format
Jdev/sda
Jdev/sdal 1000 swap none
fdev/sdaZ - ext3 i
Check In... Apply || Revert H Close
[f‘J Event Log } Inj Provision Status I
In the partitions pane, click Add.
o New Partition X
Filesystem: |swap |'|
Device: |fde\ffsda -
Mount point l:‘

fstab options: [defaults 0 0 |

mKkfs options: | |

Share host:
Share path:
Format

Size

® Fixed size 1,0005 ME

) Fill to end of disk

In the New Partition dialog, select a file system type from the Filesystem drop-down list.
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- /dev/hda — Primary IDE Disk

- /dev/hdb — Secondary IDE Disk
- /dev/sda — Primary SCSI Disk

- /dev/sdb — Secondary SCSI Disk

If you are using non-standard hosts, you can add additional storage devices to the partitioning drop-down list. The
Image Administration Service profile, SCMHOME/etc/ImageAdministrationService.profile, allows you to configure
non-standard hard drives. This profile contains options that allow you to set the drive name (available when partitioning
the disk at the time of creating or modifying an image) and the prefix for a partition on the drive (if one exists). By
default these values are commented out, but may be commented in as needed. Once drives are configured, they become
available via Cluster Manager.

Profile options are as follows:
partitioning.devices:cciss/c0d0
The name of the storage device where the device file is located (e.g., /dev/cciss/c0d0).

partitioning.devices.cciss/c0d0.naming:p
The partition prefix for the device defined by the previous key (e.g., cciss/c0d0).

In this example, the partition will look like c0dOp1, c0d0Op2, and so on.

Enter a Mount Point or select one from the drop-down list.

(Optional) Enter the fstab options. The /etc/fstab file controls where directories are mounted and, because Cluster
Manager writes and manages the fstab on the hosts, any changes made on the hosts are overwritten during
provisioning.

7. (Optional) Enter the mkfs options to use when creating the file system (such as, file size limits and symlinks). For
example, to change the default block size for ext3 to 4096, enter -b 4096 in the mkfs options field.

(Optional) If creating an NFS mount, enter the NFS host.
(Optional) If creating an NFS mount, enter the NFS share.

10. (Optional) Clear the Format option to make the partition exempt from being overwritten or formatted when you
provision the host. This may be overridden by the Force Partitioning option or from the boot.profile file (see
Select an Image and Provision on page 43 and boot.profile on page 40).

After partitioning the hard disks on a host for the first time, you can make a partition on the disk exempt from being
overwritten or formatted when you provision the host. However, deciding not to format the partition may have an
adverse affect on future payloads — some files may remain from previous payloads. This option is not allowed if the
partition sizes change when you provision the host.
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11. Select the partition size:
- Fixed size allows you to define the size of the partition (in megabytes).
- Fill to end of disk allows you to create a partition that uses any space that remains after defining partitions with
fixed sizes.

You should allocate slightly more memory than is required on some partitions. To estimate the amount of memory
needed by a partition, use the du -hc command.

12. Click Apply.
13. (Optional) Click Check In to import the image into VCS.
14. Click Apply.

Cluster Manager generates the boot.profile file each time you save an image. For a description of the information
contained in this file, see boot.profile on page 40.

Provisioning

The Cluster Manager provisioning service allows you to create an image from a payload and kernel, then apply that
image to multiple hosts. When provisioning, you can select a versioned image stored in VCS or use a working copy of
an image from your working directory. The following illustration depicts an image that is provisioned to multiple hosts.

-

+  Kernel
_ 2
|

Select an Image and Provision

1. Select the hosts you want to provision from the navigation tree (use the Shift or Ctrl keys to select multiple hosts).

If you want to provision a host using the latest revision of an image stored in VCS, you can right-click a host and select
Provision. Cluster Manager displays a pop-up menu and allows you to select the image you want to use to provision.

. Host
Payload

Host g

Host

Image - 2 Host

Provision
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Select an Image and Provision

2.

Select the Provisioning tab.

g Cluster

) computehosts
=~ nodel
“~~node2
e
“~~nodeq

%) masterhost
& owxhost

File Edit View Actions Help
O-0-E Oé 393 2%
- Configuration ' Instrumentation | % Provisioning

JVersinnm Images [ Warking Images]

ISLE Cluster Manager - cwxhost

4l import

4l sles-10.2

I: Al sles-10.2 (1)
4l sles-10.2 ¢2)

4l stock_std_nodes

Image Properties

Architecture: amdé4

Kernel: sles-10.2, revision 1
Payload: sles-10.2, revision 1

Advanced...

l

& Event Log I lb] Provision Status I

irex |§
)
=8
2
I3
&
&
-
B
4
=
5
&
[ 2]
=
I
2
@
Upgrade Provision

3. Select the Versioned Images or Working Images tab.

A “Versioned” image is a revision of an image that is checked into VCS. A “Working” image has not been checked into
VCS and is currently present in the working area (for example, SCMHOME/imaging/<user>/images). This allows you
to test changes prior to checking in.

A “Working Copy” of an image is currently present in the working area (for example, SCMHOME/imaging/<user>/

images). A “Versioned” image is a revision of an image stored in VCS.

7.

Select the image you want to use to provision the hosts.

(Optional) Click the Advanced button to display the Advanced Options dialog.

This dialog allows you to override partitioning, payload, and kernel verbosity settings.

Click Provision to distribute the image to the selected hosts.

Cluster Manager asks you to confirm your action.

Click Yes to provision the hosts.

When you click Yes, Cluster Manager provisions the hosts using the new image. Any pending or running jobs on the
selected hosts are lost.
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Right-click Provisioning
1. Select the hosts you want to provision from the navigation tree (use the Shift or Ctrl keys to select multiple hosts).

2. Right-click a host and select Provision.
Cluster Manager displays a po-pup menu and allows you to select the image you will use to provision.

Right-click provisioning uses the latest revision of an image stored in VCS.
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Glossary

Anti-aliasing A technique used to smooth images and text to improve their appearance on screen.
Architecture-independent Allowing hardware or software to function regardless of hardware platform.
Baud rate A unit of measure that describes data transmission rates (in bits per second).

Block size The largest amount of data that the file system will allocate contiguously.

boot.profile A file that contains instructions on how to boot a host.

Boot utilities Utilities added to the RAM Disk that run during the boot process. Boot utilities allow you to create such
things as custom, pre-finalized scripts using utilities that are not required for standard Linux versions.

Cluster Clustering is a method of linking multiple computers or compute hosts together to form a unified and more
powerful system. These systems can perform complex computations at the same level as a traditional supercomputer by
dividing the computations among all of the processors in the cluster, then gathering the data once the computations are
completed. A cluster refers to all of the physical elements of your SGI solution, including the Cluster Manager Master
Host, compute hosts, Cluster Manager, UPS, high-speed network, storage, and the cabinet.

Cluster Manager Master Host The Cluster Manager Master Host is the host that controls the remaining hosts in a
cluster (for large systems, multiple masters may be required). This host is reserved exclusively for managing the cluster
and is not typically available to perform tasks assigned to the remaining hosts.

DHCP Dynamic Host Configuration Protocol. Assigns dynamic IP addresses to devices on a network.

Diskless host A host whose operating system and file system are installed into physical memory. This method is
generally referred to as RAMfs or TmpFS.

EBI An ELF Binary Image that contains the kernel, kernel options, and a RAM Disk.

Event engine Allows administrators to trigger events based on a change in system status (e.g., when processors rise
above a certain temperature or experience a power interruption). Administrators may configure triggers to inform users
of a specific event or to take a specific action.

Ext Original extended file system for Linux systems. Provides 255-character filenames and supports files sizes up to 2
Gigabytes.

Ext2 The second extended file system for Linux systems. Offers additional features that make the file system more
compatible with other file systems and provides support for file system extensions, larger file sizes (up to 4 Terabytes),
symbolic links, and special file types.

Ext3 Provides a journaling extension to the standard ext2 file system on Linux. Journaling reduces time spent
recovering a file system, critical in environments where high availability is important.

Group A group refers to an organization with shared or similar needs. A cluster may contain multiple groups with
unique or shared rights and privileges. A group may also refer to an administrator-defined collection of hosts within a
cluster that perform tasks such as data serving, Web serving, and computational number crunching.
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Health monitoring An element of the Instrumentation Service used to track and display the state of all hosts in the
system. Health status icons appear next to each host viewed with the instrumentation service or from the navigation tree
to provide visual cues about system health. Similar icons appear next to clusters, partitions, and regions to indicate the
status of hosts contained therein.

Host An individual server or computer within the cluster that operates in parallel with other hosts in the cluster. Hosts
may contain multiple processors.

image.profile A file used to generate boot.profile. This file contains information about the image, including the
payload, kernel, and partition layout.

IP address A 32-bit number that identifies each sender or receiver of information. In order to transmit or receive
information on the network.

Kerberos Kerberos is a network authentication protocol. It is designed to provide strong authentication for client/
server applications by using secret-key cryptography.

Kernel The binary kernel, a .config file, System.map, and modules (if any).

LDAP Lightweight Directory Access Protocol is an Internet protocol that email programs use to look up contact
information from a server.

Listener A listener constantly reads and reviews system metrics. Configuring listener thresholds allows you to trigger
loggers to address specific issues as they arise.

Logger The action taken when a threshold exceeds its maximum or minimum value. Common logger events include
sending messages to the centralized Cluster Manager message log, logging to a file, logging to the serial console, and
shutting down the host.

MAC address A hardware address unique to each device installed in the system.
Metrics Used to track logger events and report data to the instrumentation service (where it may be monitored).

MIB Management Information Base. The MIB is a tree-shaped information structure that defines what sort of data can
be manipulated via SNMP.

Monitors Monitors run periodically on hosts and provide the metrics that are gathered, processed, and displayed using
the Cluster Manager instrumentation service.

Multi-user Allows multiple administrators to simultaneously log into and administer the cluster.

Netmask A string of 0's and 1's that mask or screen out the network part of an IP address so only the host computer
portion of the address remains. The binary 1's at the beginning of the mask turn the network 1D portion of the IP address
into 0's. The binary 0's that follow allow the host ID to remain. A commonly used netmask is 255.255.255.0 (255 is the
decimal equivalent of a binary string of eight ones).

NIS Network Information Service makes information available throughout the entire network.

Node See Host.

Partition Partitions are used to separate clusters into non-overlapping collections of hosts.

Payload A compressed file system that is downloaded via multicast during the provisioning process.
Plug-ins Programs or utilities added to the boot process that expand system capabilities.

RAID Redundant Array of Independent Disks. Provides a method of accessing multiple, independent disks as if the
array were one large disk. Spreading data over multiple disks improves access time and reduces the risk of losing all
data if a drive fails.

RAM Disk A small, virtual drive that is created and loaded with the utilities that are required when you provision the
host. In order for host provisioning to succeed, the RAM Disk must contain specific boot utilities. Under typical
circumstances, you will not need to add boot utilities unless you are creating something such as a custom, pre-finalized
script that needs utilities not required by standard Linux versions (e.g., modprobe).
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RHEL Red Hat Enterprise Linux.

Region A region is a subset of a partition and may share any hosts that belong to the same partition—even if the hosts
are currently used by another region.

Role Roles are associated with groups and privileges, and define the functionality assigned to each group.

Secure remote access The ability to monitor and control the cluster from a distant location through an SSL-encrypted
connection. Administrators have the benefit of secure remote access to their clusters through any Java-enhanced
browser. Cluster Manager can be used remotely, allowing administrators access to the cluster from anywhere in the
world.

Secure Shell (SSH) SSH is used to create a secure connection to the CLI. Connections made with SSH are encrypted
and safe to use over insecure networks.

SLES SuSE Linux Enterprise Server.

Version branching The ability to modify an existing payload, kernel, or image under version control and check it back
into VCS as a new, versioned branch of the original item.
Version Control System (VCS) The Cluster Manager Version Control System allows users with privileges to manage

changes to payloads, kernels, or images (similar in nature to managing changes in source code with a version control
system such as CVS). The Version Control System supports common Check-Out and Check-In operations.

Versioned copy A versioned copy of a payload, kernel, or image is stored in VCS.

Working copy A working copy of a payload, kernel, or image is currently present in the working area only
(e.g., SCMHOME/imaging/<user>/ payloads). Working copies are not stored in VVCS.
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